User Guide
Version 1.0 beta

CaverSoft, Ltd.
HCI Laboratory, Faculty of Informatics, Masaryk University
Loschmidt Laboratories, Faculty of Science, Masaryk University

The software package is provided "as is" without warranty of any kind. In no event shall the author or his
employer be held responsible for any damage resulting from the use of this software. The program package, including source codes, example data sets, executables, and this documentation, is distributed free of
charge for academic use only. Permission is granted to copy and use programs in the package provided no
fee is charged for it and provided that this copyright notice is not removed.
For the commercial version, please contact CaverSoft, Ltd. – info@caversoft.com.
Recommended Citation:
Chovancová, E., Pavelka, A., Beneš, P., Strnad, O., Brezovský, J., Kozlíková, B., Gora, A., Šustr, V., Klvaňa, M.,
Medek, P., Biedermannová, L., Sochor, J. Damborský, J. (2012). CAVER 3.0: A Tool for the Analysis of
Transport Pathways in Dynamic Protein Structures. PLoS Computational Biology, 8: e1002708.
Developers team:
Eva Chovancová, Barbora Kozlíková, Jan Brezovský, Vilém Šustr, Antonín Pavelka, Ondřej Strnad, Lukáš
Daniel, Petr Beneš, David Bednář, Matúš Kotry, Martin Bezděka, Jiří Sochor, Jiří Damborský
Scientific marketing:
Ondřej Valina

Contacts:
CaverSoft, Ltd.
Nadační 581/1
621 00 Brno
Czech Republic
Webpage: www.caversoft.com
Phone: +420 605 868 731, +420 702 076 535
E-mail: info@caversoft.com

Human Computer Interaction Laboratory
Faculty of Informatics, Masaryk University
Botanická 68a,
602 00 Brno,
Czech Republic
Webpage: http://decibel.fi.muni.cz
Phone: +420 549 496 939, Fax: +420 549 491 820

Loschmidt Laboratories, Department of Experimental Biology
Research Centre for Toxic Compounds in the Environment
Faculty of Science, Masaryk University
Kamenice 5, Bld. A13, 625 00 Brno, Czech Republic
Webpage: http://loschmidt.chemi.muni.cz
Phone: +420 549 493 467, Fax: +420 549 492 556

Project webpage: www.caver.cz
E-mail: caver@caver.cz

© Copyright 2005-2013
CaverSoft Ltd., Brno, Czech Republic
HCI Laboratory, Faculty of Informatics, Masaryk University, Brno, Czech Republic
Loschmidt Laboratories, Institute of Experimental Biology, Faculty of Science, Masaryk University, Brno,
Czech Republic

Contents
1

2

Introduction ……………………………………………………………………………………………………………………………………………
1.1

About CAVER Analyst …………………………………………………………………………………………………………………..

1.2

Hardware and Software Requirements ……………………………………………………………………………………….

1.3

User Support ……………………………………………………………………………………………………………………………….

Software Features ………………………………………………………………………………………………………………………………….
Workspace…...………………………………………………………………………………………………………………………………
Main Menu .......................................................................................................................................
Top Toolbar ………………………………………………………………………………………………………………………………….

3
3
4
7

Windows and their Features .....................................................................................................................

9

2.1
2.2
2.3

3

3.1
3.2
3.2.1
3.3
3.4
3.5
3.6
3.7
3.8
3.9
3.10
3.10.1
3.10.2
3.11
3.12
3.13
3.14

4

1
1
1
2

Structures Overview Window ……………………………………………………………………………………………………… 9
Visualization Window …………………………………………………………………………………………………………………… 13
Manipulation with the Scene ……………………………………………………………………………………………………….. 13
Tunnel Computation Window ………………………………………………………………………………………………………. 14
Tunnel Advanced Settings Window ………………………………………………………………………………………………. 18
Tunnel Statistics Window ……………………………………………………………………………………………………………… 19
Structure Sequence Window ………………………………………………………………………………………………………… 24
Structure Selections Window ………………………………………………………………………………………………………. 24
Structure Dynamics Window ………………………………………………………………………………………………………… 26
Structure Properties Window ……………………………………………………………………………………………………….. 26
Tunnel Graph Window ………………………………………………………………………………………………………………….. 27
Static case …………………………………………………………………………………………………………………………………….. 27
Dynamic case ……………………………………………………………………………………………………………………………….. 28
Colors Window …………………………………………………………………………………………………………………………….. 30
Structure Alignment Window ……………………………………………………………………………………………………….. 31
Structure Clip Plane Window ……………………………………………………………………………………………………….. 31
Surface Configuration Window …………………………………………………………………………………………………….. 32

Guided Examples …………………...................................................................................................................... 34
4.1
4.2
4.3
4.4
4.5

Example 1 – Static Case ………………………………………………………………………………………………………………… 34
Example 2 – Dynamic Case …………………………………………………………………………………………………………… 37
Example 3 – Case study – Engineering enzyme activity …………………………………………………………………. 39
Example 4 – Case study – Engineering enzyme stability ………………………………………………………………… 41
References ……………………………………………………………………………………………………………………………………. 43

1 Introduction
1.1 About CAVER Analyst
CAVER Analyst 1.0 is a professional software program for the analysis of access pathways to buried active
sites in proteins. Many proteins possess deeply buried binding sites in the protein core. The size, shape,
physico-chemical properties and dynamics of pathways leading from the protein surface to the core are of
the utmost importance for the accessibility and biological activity. Accessibility of the pathways for the
ligands is as important as the ligand’s fit to the binding site itself. CAVER Analyst 1.0 assists with calculation,
analysis, visualization and rational re-design of the ligand access pathways.

CAVER Analyst 1.0 offers a number of features assisting analysis of the access pathways in protein structures:








Visualization of all identified access pathways.
Frequency and average overall cost of individual pathways.
Average radius, length, volume and curvature of a given pathway.
Maximum and average bottleneck of a given pathway.
Residues lining a given pathway and bottleneck.
Detailed pathway profiles.
Pathway dynamics by animation and heat plots.

1.2 Hardware and Software Requirements
Minimal configuration:
 Java 1.7
 1 GB RAM
 32-bit architecture
 Intel HD family graphics adapter
Recommended configuration:
 Java 1.7 or later
 8 to 16 GB RAM
 64-bit architecture
 AMD Radeon or NVIDIA GeForce family graphics card
Regardless of the recommended configuration, CAVER Analyst is platform-independent; therefore the
following platforms are supported:
 Windows XP, Vista, 7 or 8
 Mac OS X 10.6 or later
 Linux major distributions including Fedora Core, Red Hat and Ubuntu
1

1.3 User Support
More than 5,000 users world-wide have downloaded some version of CAVER and many of them have
provided invaluable feedback. Users’ comments and recommendations have always been instrumental for
the development of the software thus we are grateful for any kind of feedback from your experience with
the CAVER Analyst.
To obtain more information, provide recommendation, request new features or report bugs in CAVER
Analyst, please register at our webpage at www.caver.cz, or write us at caver@caver.cz.
Users of the commercial version can also utilize a user support provided by CaverSoft, Ltd. at
info@caversoft.com.
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Software Features

2.1 Workspace
The workspace of the CAVER Analyst application consists of the main menu, toolbar and four main panels
(see figure 2.1). The top part of the left panel (control panel) is used to control loaded structures
(Structures Overview window) and to manage existing selections (Structure Selections window). The
bottom of the left panel is reserved for working with various tools, e.g. clip planes (Structure Clip Plane
window), structure alignment of two structures (Structure Alignment window) and controlling probe size
and transparency of protein surface (Surface Configuration window).
The main menu and toolbar provide access to all functions of the application. The toolbar has a shortcut to
the most often used functions, such as loading the molecule from a disc, downloading it online from the
PDB database, saving and loading the current session, changing the visualization style of active structures
and tunnels and others. Full descriptions will be provided later in this document.
The bottom panel (explorer panel) allows users to explore primary protein structure and make residue
selections (Structure Sequence window), to control the animation playback when a dynamic simulation is
loaded (Structure Dynamics window) and to explore various tunnel statistics – lining residues, bottlenecks,
etc. (Tunnel Computation Statistics window).
The right panel (computation panel) allows users to choose input parameters for tunnel computation and
to launch their calculation (Tunnel Computation window). This area also contains the Color window for
changing color schemes for individual atoms, residues or chains for visualization purposes. When you want
to see more information about loaded structures, you can use the Structure Properties window, which will
also be displayed in the right panel.
Finally, the central visualization panel serves for visualization and view control (Visualization window,
visualizing and setting of graph statistics of computed tunnels (Tunnel Graph window) and for displaying log
messages (Log window).

Figure 2.1: CAVER Analyst work area
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IMPORTANT NOTE
Windows in one panel can be switched by clicking their title header. Each panel can be closed or reopened
via the Main Menu. Their size can be deliberately altered by dragging. Users can also design their own
layout by dragging the windows to the desired panel (drag the title header). They can return to the default
layout and size in the main menu: View/Reset Windows. Windows can also be undocked and separated
from the workspace.

2.2 Main Menu
Top main menu contains the following categories:


File
o

o

o

o
o

o
o



View
o
o

o

o

Open Structure(s)…
Allows the user to open a structure from the PDB file stored on the hard drive. CAVER
Analyst creates its own caver folder (in Windows in C:/Documents and
Settings/username/caver). This is where all downloaded PDB files are stored.
Open Molecular Dynamics…
Allows the user to open a set of PDB files representing molecular dynamics stored on the
hard drive.
Download Structure…
Opens the dialog window enabling the user to enter the PDB ID of the molecule, which will
then be downloaded from the PDB database.
Load Workspace…
Allows the user to load sessions previously saved on the hard drive (in .cws format).
Save Workspace…
Saves the current CAVER Analyst session (all loaded structures, computed tunnels and their
settings) to the hard drive (.cws format).
Application Log
Opens the center panel with information about performing actions.
Exit
Closes the CAVER Analyst application.

Visualization Window
Opens the center panel containing a visualization of the scene. More details in section 3.2.
Highlight Selection
Enables/disables the highlighting of atoms, residues or chains (according to the settings in
the Selection window) when passing over them with the cursor.
Surface Configuration
Opens the Surface Configuration window in the bottom left panel. It allows the user to
change the transparency of the molecular surface and the probe size, which controls the
preciseness of the surface. It has no effect on other visualization styles.
Scene Fog
Enables/disables visualization of fog, enhancing the perception of depth in the scene.
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o

o

o
o

o



Scene Drag Rotation
When enabled, users can launch automatic rotation of the whole scene. The direction and
speed of rotation is determined by dragging the mouse.
Orthographic Projection
Allows the user to change the projection type. Orthographic projection does not distort the
scene.
Reset Camera
Resets the scene so the loaded structures are centered to the viewport.
Toolbars
Here users can customize the Top Toolbar section – show/hide groups of related icons,
change icon size or customize the toolbar.
 File – shows/hides icons related to opening or downloading structures.
 Workspace – shows/hides icons related to loading or saving current session.
 Computation – shows/hides icon related to tunnel computation.
 Structure Visualization – shows/hides icons related to changing visualization
modes of structures.
 Tunnel Visualization – shows/hides icons related to changing visualization modes
of tunnels.
 Tools – shows/hides icons related to additional tools (currently color chooser and
making screenshots).
 Small Toolbar Icons – changes the icon size.
 Reset Toolbars – sets all toolbars to their default settings.
 Customize – add arbitrary icons to the Top Toolbar section.
Reset Windows
All windows are returned to their default position and size.

Visualization
Allows the user to change the visualization style of an activated protein structure or
computed tunnels. If no tunnels for a given structure have been computed, changing their
visualization style is disabled.
Structure Visualization Styles:
o Points
Visualizes molecule as crosses positioned into the center of each atom.
o Dots
Displays atoms as dotted spheres of van der Waals radii.
o Wireframe
Represents a molecule with its bonds visualized as lines.
o Alpha Trace
Visualizes the polypeptidic chain of a protein by connecting the C-alpha atoms of amino
acids.
o Sticks
Displays molecular bonds as three-dimensional sticks.
o Balls & Sticks
Shows both atoms and bonds of the protein.
o Van der Waals Radii
Molecules are represented by a set of spheres with van der Waals radii.
5

o
o

o

o

o

o

o

o

o



Cartoon
Representation of secondary structures.
Surface
Visualization of the protein surface. Its transparency can be set using the
Visualization/Transparency function available from the main menu.
Tunnel Visualization Styles:
Points
Displays tunnels using Tunnel Subdivision Surface, where the surface is represented by
dots. This method can also be used for visualizing tunnels in molecular dynamics.
Centerline
Shows a line representing the centerline of a tunnel. This method can also be used for
visualizing tunnels in molecular dynamics.
Dots
Displays tunnels as a dotted surface. This method can also be used for visualizing tunnels in
molecular dynamics.
Spheres
Shows the tunnel as a set of intersecting spheres. This method can also be used for
visualizing tunnels in molecular dynamics.
Tube Surface
Represents the tunnel as a tube along the centerline. This method can also be used for
visualizing tunnels in molecular dynamics.
Detailed Surface
This is the widest and most precise tunnel representation. This method takes more
computation time, thus it is used only in a static case.
Clusters (all snapshots in one)
This method is available only when computed tunnels in dynamics are available. It displays
the centerlines for all tunnels computed for all snapshots at once. Centerlines are colored
according to their related clusters.

Structure
o Overview
Opens the top left panel containing a list of all loaded structures. More details in section
3.1.
o Selections
Opens the top left panel containing a list of all created selections. More details in section
3.7.
o Alignment
Opens the Structure Alignment window in the bottom left panel. Details in section 3.11.
o Clip Plane
Opens the Structure Clip Plane window in the bottom left panel. Details will be described in
section 3.12.
o Sequence
Opens the bottom panel containing a sequential representation of all loaded proteins.
More details in section 3.6.
o Dynamics
Opens the bottom panel containing control buttons for animating molecular dynamics.
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o





More details in section 3.8.
Properties
Opens the top right panel, which contains detailed information about the active structure.
More details in section 3.9.

Tunnel
o Computation
Opens the top right panel, enabling entry parameters for tunnel computation. More details
in section 3.3.
o Statistics
Opens the bottom panel with detailed statistics about computed tunnels – clusters, lining
residues, bottlenecks, etc. More details in section 3.4.
o Graph
Opens the center panel containing a window which displays various tunnel statistics. More
details in section 3.10.
o Advanced Settings
Opens the top right panel, enabling the user to view and edit all parameters influencing the
CAVER algorithm for tunnel computation. More details in section 3.4.
Help
o About CAVER Analyst
Information about product version and copyright.
o User guide
Opens this user guide in the pdf format.

2.3 Top Toolbar
The top toolbar contains buttons with shortcuts to the most frequently used functions (see figure 2.3).

Figure 2.3: Toolbar icons

Functions of icons (from left to right):
 Open Structure(s)…
Opens a dialog window for selecting a PDB file from the hard disc.
 Open Molecular Dynamics…
Opens a dialog window for selecting a set of PDB files the from hard disc which represent
molecular dynamics.
 Download Structure…
Allows the user to enter a 4-character PDB ID for a molecule, which will then be
downloaded from the PDB database.



Load Workspace…
Opens a dialog window for selecting a previously stored working session in .cws format.
Save Workspace…
Opens a dialog window where the user selects the destination for saving the current
working session in .cws format.
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Changing visualization styles of molecules and tunnels (they influence only the “active” structures and
tunnels – highlighted in the Structure window and more styles can be activated simultaneously):


















Structure Points
Molecules are represented by crosses in the centers of all atoms.
Structure Dots
Atoms are represented by dotted spheres with van der Waals radii.
Structure Wireframe
Molecules are rendered by lines representing bonds between atoms.
Structure Alpha Trace
C-alpha atoms of all amino acids are connected and interpolated – it displays the
polypeptidic chain in a simple manner.
Structure Sticks
Molecules are represented by 3D sticks showing bonds between atoms.
Structure Balls & Sticks
The most detailed representation of a molecule. It displays all atoms and bonds.
Structure Van der Waals Radii
Atoms are represented by spheres of van der Waals radii.
Structure Cartoon
Molecules are displayed using secondary structures – helices, sheets, coils.
Structure Surface
Displays the molecular surface of the protein. Surface preciseness can subsequently be
refined – see section 3.14.
Tunnel Points
Tunnels are visualized using a dotted subdivision surface. It can also be animated.
Tunnel Centerline
Tunnels are displayed as a line representing their centerline. Also suitable for moving
tunnels in molecular dynamics.
Tunnel Dots
Tunnels are displayed as a smooth surface (Tunnel Tube Surface) represented by dots.
Tunnel Spheres
Tunnels are represented by intersecting spheres positioned on the tunnel centerline. Also
suitable for visualizing tunnel dynamic changes.
Tunnel Tube Surface
A novel method for tunnel visualization using a smooth surface. It is also possible to use
this representation in molecular dynamics.
Tunnel Detailed Surface
The most exact representation of tunnel boundaries in surface form. It is also possible to
use this representation in molecular dynamics. Moreover, the user can change the
preciseness of the tunnel surface by changing the probe size – see section 3.14.
Tunnel Clusters (all snapshots in one)
This representation is suitable only for tunnels computed in a trajectory. It displays tunnels
as centerlines and visualizes tunnels from all snapshots at once. The centerline color
determines individual clusters detected in the computation phase.
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Other functions:
 Colors
Opens the Colors window for changing colors of different protein parts (see section 3.9).
 Screen Capture
Allows the user to store current snapshot of the visualization window in the .png, .bmp or
.jpg format.
 Fog
Allows the user to turn fog on and off in the scene. Fog can enhance the perception of
depth in the scene.

3 Windows and their Features
3.1

Structures Overview Window

This window allows the user to organize all structures currently loaded into the application (see figure
3.1.1). The basic principle of manipulation with structures is as follows. When the user wants to work with a
given structure, the structure must be ACTIVE. This means that it is selected in the Structures Overview
window. A selected structure is highlighted in orange. More structures can be activated at once. Using Ctrl
+ Left Mouse Button, the user can select or deselect any structure. The Shift + Left Mouse Button
combination allows the user to select or deselect more structures between two selected structures (similar
as in other, common applications).
All structures can be selected using the “Activate All” button at the top of the window. The “Invert Active”
button switches between selected and deselected items. The “Remove Selected” and “Remove All” buttons
can remove structures from the application.

Figure 3.1.1: Structures Overview Window example
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IMPORTANT NOTE:
WHEN SOME FUNCTIONALITY OF CAVER ANALYST APPEARS TO BE DISABLED, PLEASE VERIFY THAT YOUR
DESIRED STRUCTURE IS ACTIVE!

Detailed Description of Structures Overview Window
In the Structures Overview Window loaded structures and tunnels are displayed as a list of individual rows.
Each structure row contains the 4-character PDB ID of the structure and a set of icons for direct
manipulation of the structure. The icons are (from left to right):
 Changing Visualization Style
Shows the changing style window very similar to the window which can be activated in the main
menu – Visualization.
 Colors
Switches to the Colors window for changing coloring styles.
 Lock Structure
Allows the user to lock the structure in a given position so that the user cannot rotate and move
with the structure within the scene.
 Show/Hide Structure
Shows/hides the structure in the visualization window.
 Close Structure
Removes the structure from the application.
When clicking on a structure with the right mouse button, the following menu appears:

Figure 3.1.2: Menu for each structure




Show Labels
Shows labels on all atoms in the scene.
Tunnel Computation
o Compute Tunnels…
Opens the Tunnel Computation window (see details in section 3.3).
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o










Import Tunnels…
Allows the user to import already computed tunnels from the hard drive in the .pdb
format (stored previously using tunnel export – see below).
o Import Caver 3 Outputs…
Allows the user to load the whole CAVER 3 output directory containing computed
tunnels and all statistics.
Hydrogen Computation
o Compute Hydrogens
Launches a computation of hydrogen atoms which are assigned to a given structure
and visualized.
o Configure Protonation of Titratable Residues…
Allows the user to change the protonation of titratable residues when computing
hydrogen atoms.
Align With…
Opens the Structure Alignment window (see details in section 3.12).
Select
o Waters – creates a selection containing all waters present in the PDB file of given structure.
Export
o Export to PDB – allows the user to save the current structure in PDB format to an external
file.
Properties…
Opens the Structure Properties window (see details in section 3.9).
Rename..
Allows the user to rename the structure (the new name appears in the given structure
row).
Remove
o Structure – removes the structure from the application.
o Waters – allows the user to remove water molecules from the structure. Please note that
this function cannot be undone!
o Hydrogens – removes hydrogens from the given structure. Recommended usage: when
some hydrogens are already present in the PDB file of the structure, first remove them and
then launch Compute Hydrogens.
o All Tunnels – removes all tunnels of a given structure from the application.
o Ligands… – if the input PDB file of a given structure also contains a ligand, it is recognized in
the loading phase and stored separately. This function opens the dialog window with all
ligands present in the structure and the user can select which ones should be removed.

All tunnels computed in one pass of the CAVER algorithm are grouped into one tunnel set, marked as
SET#X. Each tunnel (tunnel cluster, to be more specific) has also its own record (see figure 3.1.3). The
tunnel set is assigned to its structure and its name also contains the settings of two major computation
parameters – probe radius and clustering threshold. Moreover, individual tunnels are also named (starting
with tun_cl_# - abbreviation for tunnel cluster). They are sorted – a smaller tunnel number indicates its
greater relevance.
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Figure 3.1.3: Example of tunnel set record

Each tunnel set and tunnel record contains the following functions controlled by icons (from left to right):
 Changing Visualization Style
Shows the changing style window where the user can change the visualization style of the tunnel
(same as in Toolbar or Visualization in main menu).
 Tunnel Color
Allows the user to change the color of given tunnel.
 Show Tunnel Graph
Opens the Tunnel Graph window (see section 3.9).
 Show/Hide Tunnel
Shows/hides the tunnel in the visualized scene.
 Close Tunnel
Removes the tunnel from the application.
When clicking with the right mouse button on a specific tunnel, the following menu appears:

3.1.4: Menu for each tunnel record





Export “tun_cl_#”
Allows the user to store a given tunnel in .pdb format to the hard drive.
Rename…
Shows the dialog window for renaming a given tunnel.
Remove
Removes a given tunnel from the application.
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3.2 Visualization Window
The visualization window displays all loaded structures (if they are not explicitly hidden) and allows the user
to control them via a standard interface. The user can rotate (left mouse button click + mouse drag), scale
(right mouse button click + mouse drag) or translate them (mouse wheel button click + drag), see figure 3.2.

Figure 3.2: Visualization window with gray background color and enabled fog

3.2.1 Manipulation with the Scene
The scene can be controlled using two different approaches:
 Global manipulation – users can manipulate (zoom, rotate, move) the whole scene (with all loaded
structures at once). This can be done by using three mouse buttons.
o Left mouse button – rotation with all structures (active and inactive) around the scene center.
o Right mouse button – scales the whole scene along the Z-axis.
o Middle mouse button – translates the whole scene.
 Local manipulation – users can only manipulate active structures (highlighted in the Structures
Overview window). This manipulation is activated by pressing CTRL + mouse buttons.
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o
o
o

CTRL + left mouse button – rotation with active structures around their local center (defined by the bounding box).
CTRL + right mouse button – scales the ACTIVE structures in the Z-axis.
CTRL + middle mouse button – translates the ACTIVE structures.

3.3 Tunnel Computation Window
The Tunnel Computation window controls the computation of tunnels (see figure 3.3) – setting the binding
site position, important parameters, etc. This panel is activated by selecting the desired structure in the
Structure Overview window. In the first section, the user specifies the starting point – the initial position of
binding (or active) site. The application first searches the active site in the Catalytic Site Atlas, according to
the structure PDB ID code. When the search fails or if the user decides to select other starting point, the
active site can be set manually (by determining the surrounding atoms and/or residues, or X, Y, Z
coordinates). This starting point can be subsequently visualized in the display window using the “Show
Starting Point“ button. After that, the user chooses the desired number of tunnels they want to compute
and items included into computation (waters are excluded by default) and clicks “Compute Tunnels”.

Figure 3.3: Tunnel Computation window
14

Proper descriptions of each function of the Tunnel Computation window are as follows:
 Starting point definition
This section allows the user to set the position of the binding site.
o Known binding sites
Shows the list of active sites for a given structure. This list is loaded from the Catalytic Site Atlas (CSA) database. If no records for a given structure are present in CSA,
this section remains empty.
o Surrounding items (atoms or residues)
Displays the list of atoms or amino acids surrounding the active site. Users can manipulate this list by adding and removing atoms and/or residues. The “Restore
Items” button resets the list to initial values (loaded from CSA or empty). The “Add
Item” button opens the dialog window for setting parameters of a new atom
and/or residue included into the active site definition (see figure 3.3.1).
Firstly, the user can select a structure for which they want to define the binding
site. If this structure contains more chains, they can also choose one containing the
desired atom/residue. Then they can select atoms or residues for binding site definition. In both cases the user must know the ID of the atom or residue.
The user can add more atoms or residues at one time by dividing them by comma
(eg. 123,247,256).
Then the user must check if a given ID is present in the given structure and chain by
pressing the “Validate” button. If it succeeds, the user obtains a list of selected atoms/residues along with their name abbreviation.

Figure 3.3.1 Definition of a binding site

o

From Selection…
The binding site can be also defined by a selection (see figure 3.3.2). The user can
choose from a list of created selections (present in Structure Selections window)
and specify if the starting point should be defined by atoms or residues of the given
selection. Finally the user assigns the starting point to one of the loaded structures.
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Figure 3.3.2 Creating starting point from selection

o

o
o
o

To Selection
This option adds the list of surrounding items into the selection. If a selection is active, it adds the items to this selection. Otherwise it creates a new selection.
Absolute position
Users can set the absolute X, Y, Z coordinates of the active site.
Show Starting Point
Button activating visualization of a cross representing the active site.
Convert For Another Structure…
A given binding site can be reused for another structure (see figure 3.3.3). This performs the structure alignment and stores the binding site for selected structures as
absolute position.

Figure 3.3.3 Conversion of a binding site
o



Show connection with centre of structure
This checkbox displays the orange cross in the geometrical centre of the structure and connects it by a dashed line with the starting point. This serves for better orientation in the
space.

Starting Point Optimization
o Maximum distance (Å)
Specifies the maximum distance of the calculation starting point from the initial starting
point (for more details see CAVER 3.0 user guide).
o

Desired radius (Å)
The closest Voronoi vertex to the initial starting point, which is located within a specified
distance from the initial starting point and at least a desired_radius far from the balls rep16

resenting the input structure, which will be used as the starting point for the calculation of
tunnels (for more details see CAVER 3.0 user guide).


Tunnel Computation Settings
o Dynamic tunnel computation
Allows the user to set the range and sparsity of snapshots for which tunnels should
be computed. Active only for dynamic structures.
 From frame, To frame
The number of frames defining the first and last frame for tunnel computation (for more details see CAVER 3.0 user guide).
 Sparsity
Defines which snapshots tunnels will be computed for. For example, a
sparsity value of 5 means that tunnels will be computed in each fifth snapshot from the trajectory (for more details see CAVER 3.0 user guide).
o Approximation
Specifies the number of balls which will be used to approximate individual atoms in
the input structure (for more details see CAVER 3.0 user guide). A higher number
means more precise results but also greater memory consumption.
o Min. probe radius
Defines the desired minimal radius of computed tunnels (for more details see CAVER 3.0 user guide).
o Clustering threshold
Specifies the level of detail at which the tree hierarchy of tunnel clusters will be
cut, and thus influences the size of resulting clusters (for more details see CAVER
3.0 user guide).
o Shell depth
Specifies the maximum depth of a surface region, i.e., a part of the input structure
located below the bulk solvent region (for more details see CAVER 3.0 user guide).
o Shell radius
Specifies the radius of the shell probe which is used to define which parts of the
Voronoi diagram represent the bulk solvent (for more details see CAVER 3.0 user
guide).
o Residues included into tunnel computation
In this section the user can find all structures which are present in a given structure
(amino acids, ligands, waters, etc.). The user can select which of these structures
should be involved in a tunnel calculation.
This section includes two checkboxes:
 Detailed list
Displays the list of all amino acids present in the structure (along with their
ID).
 Exclude active selections
Excludes selections which are highlighted as active in the Structure Selections window.
o

Output directory
Allows the user to select the destination folder for the results of tunnel computation.
17

o



Set of icons for:
 Save computation settings to an external file
 Load computation settings from an external file
 Get computation settings from previously computed results

Compute Tunnels
Button for launching the tunnel computation.

3.4 Tunnel Advanced Settings Window
This window allows the user to edit all parameters which influence the results of tunnel computation (see
figure 3.4). Changing or adding arbitrary parameters is further described in the CAVER 3.0 user guide.

Figure 3.4 Tunnel advanced settings panel
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After changing a parameter, the “Save” button is enabled. To return to the default settings, the user can
use the “Restore” button. For a better orientation in the parameters, the user can jump to a section
containing the desired parameter using the combo box at the top right corner of the panel.

3.5 Tunnel Statistics Window
The Tunnel Statistics window allows the user to display statistical information about computed tunnels at
different levels of detail.
The first table displays a summary for computed tunnel clusters (see figure 3.5.1).

Figure 3.5.1 Table summarizing tunnel cluster statistics

The user can open more tunnel cluster statistics at once and they’ll be displayed as individual tabs. Each tab
is named according to the related tunnel set, tunnel cluster or individual tunnel. Each tab contains a set of
buttons and other controls for manipulation within the table.
 Save
Allows the user to save the table in the .csv format to a desired location on the hard drive.
 Summary (Clusters)
This button allows for navigation in the table. When the user switches to detailed tables
containing individual clusters (second level of detail) or tunnels (third level of detail) (see
below), this button returns to this table summarizing information about clusters.
 Cluster
This button has a similar function as the Summary (Clusters) button. It returns the user
from the third level of detail – information about individual tunnels – to the second level
containing cluster information.
 Detail (Tunnel)
Informative button, always disabled. It informs the user about the level of detail in the statistics panel.
 Hide inactive tunnels
When this checkbox is checked, the Visualization window shows only active tunnel clusters
(activated by clicking into the table on a corresponding row or activating them in the Structures Overview window – see section 3.1).
 Synchronize with visualization
Active only for molecular dynamics. When the dynamics is animated (animation can be
launched using the Structure Dynamics window – see section 3.8), it enables to animate also the statistics table.
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Visible columns
Shows the list of all available columns and allows the user to show/hide them using their
checkbox.
Show all
Displays all available columns, including the hidden ones.
Invert Visibility
Inverts the visibility of columns (the visible ones will be invisible and vice versa).

Individual columns have the following meaning:
 ID – identification of a given tunnel cluster; ranks a given cluster based on their priority.
 No – total number of tunnels belonging to a given cluster.
 No_snaps – number of snapshots with at least one tunnel with a radius >= parameter
min_probe_radius
 Avg_BR [Å] – average bottleneck radius.
 SD – standard deviation (present more times in the table, always corresponds to preceding column).
 Max_BR[Å] – maximum bottleneck radius.
 Avg_L[Å] – average tunnel length.
 Avg_C – average tunnel curvature.
 Priority – tunnel priority calculated by averaging tunnel throughputs over all snapshots (zero value
used for snapshots without tunnels).
 Avg_throughput – average tunnel throughput.

By double-clicking on a desired tunnel cluster (corresponding row in the table) the user can open the
details about the given cluster (see figure 3.5.2).

Figure 3.5.2 Table containing information about individual cluster

This table activates the “Cluster” button. To return to the summary about all clusters, the user can press
“Summary (Clusters)” button. This table contains the following columns:
 Snapshot – name of the input structure, in which the cluster was identified.
 Tunnel cluster – the ID of the tunnel cluster to which a given tunnel belongs (corresponds to the
Tunnel cluster ID in the summary.txt.
 Tunnel – ID of a given tunnel in a given snapshot.
 Throughput – the throughput of a given tunnel (throughput = e-cost).
 Cost – the cost of a given tunnel defined as the balance between the width and length of the tunnel.
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Bottleneck radius [Å] – the radius of the bottleneck, i.e., the narrowest part, of a given tunnel.
Length [Å] – the length of a given tunnel.
Curvature – the curvature of a given tunnel which is calculated as length/distance, where length is
the length of the tunnel (distance from the calculation starting point to the tunnel ending point
calculated along the tunnel axis) and distance is the shortest possible distance between the calculation starting point and the tunnel ending point.

By double-clicking on desired tunnel (corresponding row in the table) the user can open the details about
given tunnel (see figure 3.5.3).

Figure 3.5.3 Table containing information about individual tunnel

This table provides detailed information about an individual tunnel. It displays tunnel lining residues along
with their exact position in the tunnel. If a given residue influences the width of the tunnel in a position
given by the Distance parameter (counted from the binding site position to the outer surface), it is marked
by a green square.
Moreover, if the tunnel analysis was performed with the compute_bottleneck_residues parameter set to
yes, this table also shows the bottleneck residues which line the narrowest part of the tunnel. These
residues are marked with a blue square.
A yellow square represents the selected residue (it is also added to the active selection). It can be selected
using the left mouse button. Users can also utilize the combination with Shift and Ctrl having the standard
meaning. Selection can be deselected using the Ctrl+D.
If the bottleneck residues were not calculated, the user can start their calculation in the Structure window.
By clicking with the right mouse button on a desired tunnel set and choosing “Statistics → Bottlenecks“ the
user can also compute the bottleneck residues. Reopening the statistics table with details about clusters
(choosing “Statistics → Tunnels“ in the same window as with bottlenecks) displays blue squares representing bottleneck residues.
The rows of the table represent one sphere contained in the tunnel representation. It starts from the
binding site and ends at the protein surface. The green squares in each row signify their presence around
the sphere.
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The columns of the table have the following meaning:
 Length [Å] – the Euclidean distance between the first sphere of the tunnel and the current sphere
(in given table row).
 Individual tunnel lining residues – a set of columns; each column represents one residue which
was present at least once at the tunnel neighborhood. Each column is named according to the oneletter amino acid abbreviation and it’s PDB ID (e.g. A156).
 X, Y, Z – coordinates of the corresponding sphere centre.
 Distance [Å] – represents the distance of the current sphere from the first sphere of the tunnel,
calculated along the tunnel centerline. It depends on the tunnel_sampling_step parameter.
 Radius [Å] – radius of the corresponding sphere.

Residues table
This table provides detailed information about the tunnel lining residues of a given tunnel set (see figure
3.5.4).

Figure 3.5.4 Table containing information about residues lining given tunnel set

Each row of the table represents one tunnel cluster.
Each column of the table represents an amino acid which was marked as a tunnel lining residue at least
once throughout the whole tunnel set.
The green squares mark those residues which line the corresponding tunnel cluster. The yellow squares
determine the selected residues.
The table contains the following controls:
 Save
Allows the user to save the table in the .csv format to a desired location on the hard drive.
 Side chain only
Shows residues where at least one side chain atom of a given residue lines a given tunnel.
For this purpose, all atoms except those named H, N, C, O, CA or HA are considered as side
chain atoms.
 Minimum residue occurence
This parameter is enabled only when analyzing trajectories of molecular dynamics. It signifies the percentage of a given residue which lines a tunnel during the whole dynamics. For
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example, when this number is set to 60%, the user obtains a set of residues which formed
the tunnel in at least 60% of the snapshots of the trajectory (so the less frequent ones are
filtered out).
Visible columns
Shows the list of all available columns and allows the user to show/hide them using their
checkbox.
Show all
Displays all available columns, including hidden ones.
Invert Visibility
Inverts the visibility of columns (the visible ones will be invisible and vice versa).

Bottlenecks table
This table contains detailed information about the bottlenecks of a given tunnel set (see figure 3.5.5).

Figure 3.5.5 Table containing information about bottlenecks of given tunnel set

The controls of the table are similar to the Residues table but some have slightly different meanings.
 Save
Allows the user to save the table in the .csv format to a desired location on the hard drive.
 Minimum bottleneck occurence
Takes into account all tunnels in a given cluster and their bottleneck residues. This number
signifies the frequency of occurrence of these residues in the cluster. For example, a value
of 30% means that a given row remains when all three bottleneck residues have the
occurrence in the corresponding tunnel cluster of at least 30%.
 Visible columns
Shows the list of all available columns and allows the user to show/hide them using their
associated checkboxes.
 Show all
Displays all available columns, including hidden ones.
 Invert Visibility
Inverts the visibility of columns (the visible ones will be invisible and vice versa).
Each row of the table contains information about one tunnel and its bottleneck. The columns have the
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following meaning:
 Snapshot – name of the input structure.
 Cluster – ID of a tunnel cluster to which a given tunnel belongs (corresponds to the Tunnel cluster
ID in the summary.txt).
 Tunnel – ID of a given tunnel in a given snapshot.
 Throughput – throughput of a given tunnel (throughput = e-cost).
 Cost – the cost of a given tunnel defined as the balance between width and length of the tunnel.
 X, Y, Z – coordinates of the center of the sphere forming the bottleneck.
 Radius [Å] – radius of the sphere forming the bottleneck.
 Individual bottleneck lining residues – residues located within the specified distance from the bottleneck of a given tunnel. They are ordered from the closest to the most distant ones.

3.6 Structure Sequence Window
This window shows the primary structure of all loaded molecules (see figure 3.6). Each row consists of the
following sections:
 Structure name
 List of one-letter abbreviations of residues
Clicking the right button mouse on a residue shows the list of all atoms of a given residue.

Figure 3.6: Structure Sequence Window

3.7 Structure Selections Window
The selections window allows the user to create a selection of atoms, residues and chains. This selection
can be performed within one molecule or can cover parts of more structures. The Selections window has
the following functions:
 New…
Allows the user to create a new selection with a user-specified name.
 Atoms
Allows the user to select individual atoms.
 Residues
Allows the user to select whole residues.
 Chains
Allows the user to select whole polypeptidic chains.

Each selection has its own record. The record contains:
 Selection name
Displays the name of a given selection.
 Changing visualization style
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Allows the user to change the visualization style of a given selection. Supported styles are:
Dots, Sticks, Balls & Sticks, Van der Waals Radii, Surface.
Selection color
Allows the user to change the color of a given selection in the scene.
Show/Hide selection
Shows or hides a given selection in the scene.
Lock selection
Allows the user to lock the selection in a given position so the user cannot rotate and move
the selection in the scene.
Close
Removes a selection.

Figure 3.7.1: Structure Selections Window

When clicking with the right mouse button on a selection, the following menu appears:

Figure 3.7.2: Menu for each selection

It has the following functions:
 Show residue labels
Shows labeling of residues in a selection.
 Invert
Changes the selection to include all atoms in the scene which were not selected.
 Clear
Deselect all structures of a selection.
 Convert To Starting Point…
Opens the same dialog window as the “From Selection…” button in the Tunnel Computation window (see section 3.3).
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Rename…
Opens the dialog window for renaming a selection.
Remove
Removes a selection from the application.
What’s selected?
Shows the list of atoms/residues/chains present in the selection.

3.8 Structure Dynamics Window
This window controls the playback of molecular dynamics (see figure 3.8). It is active only when dynamics
are loaded and active.

Figure 3.8: Structure Dynamics Window

The Structure Dynamics window contains the following features:
 Current frame
Shows the number of currently displayed snapshots during the animation.
 Animation step (in frames)
Defines which snapshots will be included in animation (e.g. a value of 2 means that every
second frame will be included).
 Animation speed (in frames per second)
Controls the animation speed.
 Repeat animation loop
Defines whether the entire animation will be played back in a loop.
 From frame, To frame
Defines the starting and ending snapshot of the animation.
 Animation control buttons
Standard buttons for controlling the playback of the animation (e.g. start, stop, pause, fast
forward, etc.)

3.9 Structure Properties Window
This window shows more information about active structure (see figure 3.9). It contains the PDB ID of the
structure, its classification and inner structure – the number of chains, all residues, amino acid residues,
water molecules, ligands, atoms, hetero atoms and atoms with alternate locations. The number of loaded
frames of the structure is also shown.
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Figure 3.9: Structure Properties Window

3.10 Tunnel Graph Window
This window provides settings, visualization, manipulation and animation of graph statistics of computed
tunnels. Basically, there are two types of graphs: those for static snapshots and those for molecular
dynamics (profiles and heat plots).

3.10.1 Static case

Figure 3.10.1.1: Tunnel Graph window for static case

In the static case (figure 3.10.1.1), users can:
 Save PNG
Saves the graph as a picture in the PNG format.
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Export CSV
Saves the graph as a table in the CSV format.

Users can also set the following parameters:
 Domain axis
Allows the user to select the feature which will be mapped to the X-axis.
 Range axis
Allows the user to select the feature which will be mapped to the Y-axis.
 Freeze
This function locks the currently displayed graph. It is useful when users want to combine
more graphs into one. E.g. in one graph the user can display the relationship between
tunnel length and width and also between length and distance.
 Clear
Clears the data from the Tunnel Graph window.
The Graph section contains the “Show marks” checkbox, which adds marks to the curve (see figure
3.10.1.2).

Figure 3.10.1.2: Graph with highlighted marks on the curve

The Tunnels section then shows the legend of displayed curves. The color of each curve corresponds to the
color of the corresponding tunnel in the Structures window (where the color of tunnels and their graph
curves can also be changed).

3.10.2 Dynamic case
In the dynamic case (see figures 3.10.2.1 and 3.10.2.2), users can choose between a similar representation
as the static case and heat plots of computed tunnels. Switching between these two representations can be
obtained by choosing between Tunnel Profiles and Heat map (heat plot).
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3.10.2.1 Tunnel Graph window for molecular dynamics

The visualization of dynamic tunnels using profiles has the same settings as profiles in the static case. It also
contains the following dynamics controls:
 Snapshot
Displays the currently processed and visualized snapshot. Checking the current checkbox
tightly connects the graph to Structure Dynamics window. When user starts playback in
that window, profiles of tunnels also animate.

3.10.2.2: Example of heat plot (heat map)

With the Heat map (also known as heat plot), the user can set the following parameters:
 Domain axis
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Allows the user to select the feature which will be mapped to the X-axis.
Range axis
Allows the user to select the feature which will be mapped to the Y-axis.
Scale axis
Allows the user to select the feature which will be mapped to colors specified by the range
displayed on the right side of the heat plot.
Tunnel
Allows the user to switch between heat plots of individual detected tunnels.
Clear
Clears the data from the Tunnel Graph window.

In the Radius section, the user can customize the color range of tunnel radii in the heat plot (see figure
3.10.2.3).
The user can manually set the range of radii and the color palette changes according to these new values.

3.10.2.3: Example of different settings of custom color values of tunnel radii

By clicking with the right mouse button on the graph, menu with advanced settings appears.

3.11 Colors Window
The Colors window (see figure 3.11) is used for coloring loading structures and their parts. There are four
panes representing the main coloring methods according to atoms, residues, chains, secondary structure
and the background of the whole scene. Structure is colored according to atom elements by default. For
every method there are several color schemes available, for example hydrophobicity of residues.

Figure 3.11: Colors Window
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In this window the user can choose between coloring individual atoms (according to their chemical
elements), residues, chains or secondary structures.
In all cases the user can choose between predefined Color schemes. Users can also change the colors of
individual atoms (residues, chains or secondary structures) by clicking on the desired chemical element (its
colored row).
 Apply
When changing color schemes from one type (e.g. atoms) to another (e. g. secondary
structures), this button confirms the change.
 Reset
Returns colors to the currently selected type and color scheme.
 Save…
Allows the users to save their own color scheme using the current settings.

3.12 Structure Alignment Window
This function allows the user to align two structures, shows the result in the visualization window and
computes the RMSD (Root Mean Square Deviation) value (see figure 3.12).

Figure 3.12: Structure Alignment Window

Users can select the first and second structure for alignment and press the “Compute Alignment” button.
TIP: To align more structures, it is necessary to choose one “reference” structure as a First structure and
then select a Second structure for alignment.

3.13 Structure Clip Plane Window
This window allows the user to activate work with a clip plane which can stress important features of
proteins as well as tunnels (see figure 3.13).
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Figure 3.13: Clip Plane Window

The Clip Plane window allows the user to configure the following settings and functions:
 Clip plane for structure:
Allows the user to select the structure on which the clip plane will be applied.
 Activate/Deactivate clip plane
Activates and deactivates the clip plane.
 Realign with viewport
Allows the user to orient the clip plane to the initial position (perpendicular to the user's
viewing area).
 Lock clip plane at structure rotation
When selecting this tool, the clip plane will rotate along with the molecule according to the
user's command.
 Invert clip plane polarity
The opposite site of the molecule will be clipped.
 Visualize clip plane
Allows the user to transparently visualize the clip plane.
 Clip tunnels
This function allows the user to enable or disable clipped tunnels present in the clipped
part of the molecule.
 Clip selections
This function allows the user to enable or disable clip selections present in the clipped part
of the molecule.
 Distance (from structure centre):
Shows and allows the user to set the distance between the centre of the molecule and the
clip plane.

3.14 Surface Configuration Window
The Surface Configuration window (see figure 3.14) directly influences the computed and visualized surface
of a selected structure. It is able to change the transparency of a surface for a selected structure and
change the probe size for a structure's surface and also for the Detailed Surface method for tunnel visualization.
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Figure 3.14: Surface Configuration Window
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4 Guided Examples
4.1 Example 1 – Static Case
This example will describe how to load a structure to CAVER Analyst 1.0, change its features and compute
tunnels.
The workspace for the scenario containing this example can be found in the static.cws file provided with
this supporting documentation and can be loaded by choosing “File → Load Workspace…” and selecting the
file.

A) Loading the structure
First, the user downloads the molecule from the Protein Data Bank (internet connection is required).
Choose “File → Download Structure…” and the following window appears (figure 4.1):

Figure 4.1 Dialog window for downloading the structure

Here, the user enters the PDB code of the structure (1cqw in this case) and selects the destination path
where the copy of the structure .pdb file will be stored. The user then clicks “Finish”.
The structure downloads and then appears in the Visualization window. It is also listed in the left panel –
the Structures window. By default, the currently loaded structure is marked as active – it is signified by the
orange color of the structure record in the Structures window (figure 4.2):

Figure 4.2 Activated record of the loaded structure in the Structures window
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B) Changing the visualization style
By default the structure is visualized as a Wireframe. This can be changed by clicking on the icon marked
with the blue circle in figure 4.3 and choosing desired representation.

Figure 4.3 Icon for changing the structure visualization style (marked with blue circle)

C) Setting the binding site for tunnel computation
Now the user prepares the structure for tunnel computation. First, the user opens the panel for tunnel
computation – “Tools → Tunnel Computation”. The panel opens on the right site of the application window.
Then the user must define the position of the starting point (binding site) of the calculation. In this case, the
active site of 1cqw structure is present in the CSA (Catalytic Site Atlas) database so residues surrounding
the binding site are automatically loaded into the Tunnel Computation panel (figure 4.4).

Figure 4.4 List of residues defining the starting point for 1cqw structure, loaded from the CSA database

The user can change this list of residues (add, remove residues, add atoms). To visualize the starting point
in the Visualization window, click on the “Show Starting Point” button. It displays a cross with three axes
(figure 4.5) which can be used for fine correction of the starting point position (by dragging the mouse).

Figure 4.5 Crossing with X, Y, Z axes displaying the position of starting point

D) Launching tunnel computation
Now the user can change input parameters for tunnel computation. The most important ones are present
in the Tunnel Computation window (see section 3.3); the rest can be edited in the CAVER 3 Computation
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Settings window (see section 3.6).
For the 1cqw structure, it is necessary to set the Min. probe radius to 0.7 or less (this represents the
minimal tunnel width). The smaller the value of this parameter, the more tunnels will be computed.
By pressing the “Compute Tunnels” button, the user launches the tunnel computation using the CAVER 3.0
algorithm.

E) Exploring results
Once the tunnels are computed, they appear in the Structure window under the corresponding structure
(figure 4.6). All tunnel clusters from one computation are grouped into the tunnel set. All individual tunnel
clusters are in this set.

Figure 4.6 Records for computed tunnels in the Structures window

Each set and tunnel clusters contain a set of icons for changing their visualization style, color and visibility.
The user can generate a graph of one cluster by clicking on the icon marked with blue circle in figure 4.7.

Figure 4.7 Icon for activating the graph marked with blue circle

When activated, the icon changes its color to orange and the Tunnel Graph window appears (figure 4.8).
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Figure 4.8 Graph representation of the tunnel cluster

4.2 Example 2 – Dynamic Case
This is a similar scenario but with a trajectory of molecular dynamics case.
The workspace of this example scenario is a part of this supporting material. It is found in the dynamic.cws
file and can be loaded by choosing “File → Load Workspace…” and selecting the file.

A) Loading the structure
In this example, the trajectory must be stored on the hard drive. Choose “File → Open Molecular Dynamics…” and the following window appears (figure 4.9):
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Figure 4.9 Dialog window for loading trajectory of molecular dynamics

Using “Add File(s),” the user chooses a set of PDB files representing the trajectory from the hard drive. By
clicking on the “Finish” button, the user launches the loading phase. The supplementary material contains
the example of short molecular dynamics called “md”.
After loading, the Structure Dynamics window (see section 3.8) opens automatically. It is used for animating and navigation in the trajectory.

B) Setting the binding site for tunnel computation
This phase is very similar to that in the static case. However, the CSA database does not contain any records
for trajectories of molecular dynamics. So the user must define the starting point manually – either by
defining the surrounding atoms or residues or by setting an absolute position using X, Y, Z coordinates. In
case of “md” trajectory, the starting point is defined by atoms with ID’s 578, 1609, 3258.

C) Launching tunnel computation
Again, the user can influence the results of the computation by changing parameters present in the Tunnel
Computation window (see section 3.3) or the Tunnel Advanced Settings (see section 3.6). In this case, the
Min. probe radius is set to 0.9 and in the Residues included into tunnel computation the following items
should be checked: AA, HIE, HID. The computation is launched using the “Compute Tunnels” button.

D) Exploring results
Computed tunnels can be explored by animating the trajectory using the Structure Dynamics window.
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Again, the user can generate a graph for the results by clicking on the icon marked by the blue circle (figure
4.10).

Figure 4.10 Icon for activating the graph marked with blue circle

By checking the “current” snapshot (figure 4.11) and playing the animation in the Structure Dynamics
window the graph is changing according to current snapshot.

Figure 4.11 Activating the graph animation

For molecular dynamics, the user can also open the heat map of the trajectory – see figure 4.12.

Figure 4.12 Heat plot for tunnels in the trajectory, activated by the radiobutton marked with blue circle

4.3 Example 3 – Case Study – Engineering Enzyme Activity
This example shows more complex utilization of CAVER Analyst which can be utilized for engineering
enzyme activity.
39

Redesigning access tunnels of the haloalkane dehalogenase DhaA provides 32-fold increase in activity with
toxic pollutant 1,2,3-trichloropropane (TCP). The results demonstrate the power of combining rational
design with directed evolution focused to the access tunnels. For more information see [1].

A) Loading the structures
The study was performed on the wild type and the C176Y mutation of haloalkane dehalogenase DhaA. For
this purpose users can load the wt_dhaa.pdb and m1_dhaa.pdb files which are also included in the
supporting documentation.

B) Setting the binding site for tunnel computation
The CSA database does not contain any records for these structures so the user must define the starting
point manually – by defining the surrounding residues. In both structures the active site is defined by
residues with ID’s 106, 107, 130 and 272. They can be set using the Add Item… button in the Tunnel
Computation window, section Surrounding items. It opens the following window:

Figure 4.13 Definition of the starting point

C) Launching tunnel computation
In this case the parameters present in the Tunnel Computation window (see section 3.3) or the CAVER 3
Computation Settings (see section 3.6) should have the following values:
- Maximum distance (Å) = 5
- Min. probe radius = 0.7
The computation is then launched using the “Compute Tunnels” button.
This is performed for both structures and then their structure alignment can be launched – using Structure
→ Alignment (see section 3.12).
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D) Interpretation of results
The active site of wild type DhaA is an occluded cavity with two major access tunnels (main tunnel - blue,
slot tunnel - yellow). Mutant carrying substitution in the main tunnel (C176Y) shows higher activity towards
TCP.

Figure 4.14 Main and slot tunnels of the DhaA haloalkane dehalogenase

4.4 Example 4 – Case Study – Engineering Enzyme Stability
This example shows more complex utilization of CAVER Analyst which can be utilized for engineering
enzyme stability.
In this case, the modification of residues lining the access tunnel of the haloalkane dehalogenase DhaA
increased its melting temperature by 19°C and resistance to co-solvent DMSO 4000-fold. Mutations in the
tunnel improved structural and kinetic stability, while the surface mutations did not contribute to protein
stabilization. For more information see [2].

A) Loading the structures
The study was again performed on the wild type of haloalkane dehalogenase DhaA and its mutations –
DhaA57 and DhaA80. All structures corresponding to this case are stored in the 1cqw.pdb, 4f5z.pdb and
4f60.pdb files which are also included in the supporting documentation.

B) Setting the binding site for tunnel computation
The starting point for the 1cqw.pdb structure is automatically loaded from the CSA database. This point can
be copied to the other structures using the “Convert for Another Structure…” button in the Tunnel Computation window (see section 3.3).

C) Launching tunnel computation
The parameters for tunnel computation are the following:
- For all structures the Maximum distance (Å) parameter is set to 5
- For the 1cqw and 4f5z structures the Min. probe radius is set to 0.7
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- For the 4f60 structure the Min. probe radius is set to 0.5
In the computed tunnel sets, the main tunnel is the first tunnel in the 1cqw and 4f5z structures and the
second tunnel in the 4f60 structure. In the attached workspace the other tunnels were removed.

D) Interpretation of results
In a static case, the main tunnel bottleneck of DhaA57 (yellow) increased to 1.7 Å in comparison with wild
type (1.4 Å) (blue). The bottleneck of the main tunnel in DhaA80 (red) decreased to 0.6 Å. Here we can
conclude that DhaA57 mutation extends the tunnel bottleneck.

Figure 4.15 Main tunnel of wild type DhaA and its mutations DhaA57 and DhaA80

Predicted stability effects of all possible single point mutations (227 924) in 26 different proteins from all 6
enzyme classes. Targeting the tunnel residues has 2-times higher chance to produce protein variants with
significantly improved stability than mutagenesis targeting other protein regions.

E) Graphs for tunnels
The graph statistics of computed tunnels can be visualized using the icon for graph visualization – see figure
4.16.

Figure 4.16 Blue circle shows the icon for launching the graph visualization of given tunnel set

This icon opens the Tunnel Graph window with the main tunnel from the 1cqw structure. To be able to add
the tunnel from another structure to the same graph, users have to press the “Freeze” button. Then
another tunnel can be added by pressing the same icon at figure 4.16 for the second structure. The same
process is used for the third structure. Figure 4.17 shows the resulting graph comparison of the three
studied tunnels.

42

Figure 4.17 Tunnel graph
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